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A few Words concerning this Manual 

  

Dear VirtuSurv users, 

We would like to thank you for the trust you put in us and wish you lots of success in 

your daily work with VirtuSurv. 

You can rest assured that we have done our best to develop VirtuSurv into a system that 

enables you to much more easily complete your tasks. 

In order to guarantee the best introduction into how VirtuSurv works this manual 

contains multiple examples that will demonstrate and explain the possibilities available to 

you when using this FARO product. At the beginning of this manual you will find 

instructions on installation and licence management. You are then introduced to working 

with VirtuSurv. The user interface is described in detail and the various functionalities for 

processing laser scan data with VirtuSurv are explained. You will get to know how you 

can customise VirtuSurv for your particular tasks. 

Please don't be afraid when you have questions or problems to take advantage of our 

support team. Your questions and advice concerning VirtuSurv are important to us and 

always welcome. A system like VirtuSurv depends on the ideas and creativity of its 

users. 

On this note, we are looking forward to working with you and hope you enjoy working 

with VirtuSurv. 
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1 What does VirtuSurv do? 

VirtuSurv is a standalone Windows application for displaying and the evaluating 3D laser 

scanner data from all common scanner manufacturers, with and without the use of CAD. 

Thanks to the optimized format even large scan projects are displayed fast and without 

waiting time. Different photo-like display modes allow an intuitive orientation within the scan 

and help with the analysis of the scanned object. 

The project management of VirtuSurv enables the combination of scans of different types in 

one project, if they have been referenced in the same system. Among the basic functions are 

the measurements of point coordinates and of distances between two points in the scan 

project. The distance measurement can be done across the boundaries of single scans. 

In addition it is possible to export complete projects, scans or of parts of the displayed data 

as point clouds. 

Thanks to a direct connection, coordinates and distances can be measured in the scan and 

simultaneously transferred into any Windows application. This allows to fill Excel tables, data 

bases or forms with information from laser scan data and to send geometric information into 

any CAD system. 

VirtuSurv provides macros for sending data to Windows (e.g. Excel or Rhinoceros 3D), 

AutoCAD (LT) or BricsCAD that speed up the evaluation of laser scanner data and allow a 

fast and easy start in working with VirtuSurv and your familiar software. With the help of the 

editor the macros may be customized at will. The experienced user may also create his own 

macros in order to optimize his evaluation. Once you have defined your macros, you will not 

have to switch between VirtuSurv and the target application anymore. 

With a special set of commands VirtuSurv supports processing laser scan data in Revit. 

With the function for creating a coded field book, VirtuSurv takes on the established role of 

the surveyor. It addresses users who have, so far, observed their objects coded with a total 

station, in order to automatically generate a finished drawing with the help of the codes when 

importing the measurement data into their CAD system. Now these users may also use laser 

scanner data in order to create their coded point lists, their field book. 

With VirtuSurv drawings may be generated from laser scans fast and easy without having to 

load the large and ponderous point clouds into the CAD system. 

The software may be used anywhere where measurement data are to be generated from 

laser scans, e.g.: 

 As built documentation for the conservation of historical monuments, buildings and 

architecture 

 Measurements for window construction, interior fitting, etc. 

 Survey of technical plants 
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 Archaeological excavation documentation 

 Accident and crime scene documentation 

 Conservation of evidence 
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2 Installation of VirtuSurv 

The installation of VirtuSurv consists of a number of steps which have to be carried out in 

sequence. Administrator rights are required for the installation. 

2.1 System requirements 

VirtuSurv works on Windows 7, 8, 8.1 and 10. We recommend using a computer with a 64 bit 

operating system, at least 2.5 GHz processor and a minimum of 8 GB RAM. 

2.2 Installation 

The current setup files of VirtuSurv can be downloaded from the internet site: 

setups.faro3dsoftware.com 

Please run the setup file by double clicking and following the instructions of the installation 

program. 

If you want to use the function for sending data and commands to AutoCAD (LT) or to 

BricsCAD make sure you read and observe the relevant instructions. 

2.3 Installation of VirtuSurv's AutoCAD plug-in 

Before you can use VirtuSurv's AutoCAD macros, you need to load a small plug-in to 

AutoCAD. This is done automatically during the VirtuSurv setup. Please ensure that 

AutoCAD is installed before you run the VirtuSurv setup and enable the “Install AutoCAD 

receiver” option in the according setup dialog. Note, the dialog will only be displayed if 

AutoCAD has already been installed.  

If you use more than one version of AutoCAD on your computer, please select the version 

you want to use together with VirtuSurv when you are prompted to. 

2.4 Installation of VirtuSurv's BricsCAD plug-in 

Before you can use VirtuSurv's BricsCAD macros, you need to load a small plug-in to 

BricsCAD. This is done automatically during the setup process, if BricsCAD is already 

installed on your computer.  

http://setups.faro3dsoftware.com/
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If you want to insert the plug-in later, please go to the installation folder of VirtuSurv (e.g. 

C:\Program Files\FARO\VirtuSurv v2018.0.0.26986 English) and there under 

\Receiver_Setups run the DrawToBricsCAD_receiver_setup.exe with administrative rights. 

The plug-in should now be properly installed and will be present when BricsCAD is started. 

2.5 First Start up of VirtuSurv 

Start VirtuSurv. If you have a valid license, you may now start working with VirtuSurv. 

Chapter 3 of the manual will give you an introduction. 

The licence status can be accessed using the licence manager  in the "Help" menu. 

If you do not have a valid licence, you may use VirtuSurv in Viewer mode. In Viewer mode 

you may: import and export scan data and measure coordinates and distances. You need a 

licence for sending coordinates and commands into other software packages. 

If you would like to try VirtuSurv (full version) please select a trial option in the licence 

manager. The free trial lasts several days. If you want a trial extension, please contact FARO 

or a FARO reseller. 

A detailed description of VirtuSurv license management can be found in the Knowledge 

Base. 

If you own a network license, please read the according FARO Knowledge Base article. 

https://knowledge.faro.com/Software/As-Built/VirtuSurv/License_Activation_for_VirtuSurv_2018_and_Later
https://knowledge.faro.com/Software/As-Built/VirtuSurv/License_Activation_for_VirtuSurv_2018_and_Later
https://knowledge.faro.com/Essentials/Software/License_Key_Information_for_CAM2_Measure_10-CAM2_Q-CAM2_SmartInspect-CAM2_Gage_or_SCENE?mt-learningpath=software_reference
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3 Working with VirtuSurv 

This chapter introduces you to working with VirtuSurv. First you will learn how to import and 

open scan data and then you will get an overview of the user interface of VirtuSurv. The 

following chapters will explain how to use the functions of VirtuSurv for evaluating laser 

scans, how to import data and how to generate a new project. Lastly, you will learn how to 

export scan data into point clouds. 

3.1 First steps - opening scan data 

We have prepared a sample project in order for you to immediately be able to try and get to 

know VirtuSurv. You can find it under following web link: http://download.faro-3d-

software.com/VirtuSurv/Examples/. You may also start VirtuSurv and hit the  icon in the 

Welcome screen to access this website. 

Download the EXAMPLE02_KUBIT_HOUSE_FIVESCANS.ZIP file. Save it to your computer 

and then decompress it. 

Start VirtuSurv. In the Welcome dialog click on “Open existing project” . The dialogue box 

for the selection of VirtuSurv scan files (PVS) or project files (PVP) will open: 

http://download.faro-3d-software.com/VirtuSurv/Examples/
http://download.faro-3d-software.com/VirtuSurv/Examples/
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Browse to the place, where you have saved the example from the internet. Move to the 

project directory EXAMPLE02_KUBIT_HOUSE_VSPROJECT, select the 

EXAMPLE02_KUBIT_HOUSE.PVP file and click [Open]. 

Now open the view of the third scan. In order to do so select the FARO scan 003 from the 

Project Explorer, click the right mouse button and select the "True color (RGB)" option from 

the context menu. 
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A window with the coloured scan of a living room will now be opened within the main window. 

Use the mouse wheel for zooming in or out. For panning press down and hold the mouse 

wheel. The mouse pointer will turn into a hand. If, for any reason, the pan function of your 

mouse should be inactive, please use Ctrl + right mouse button as alternative. 

Open the remaining scans from the sample project. Hint: With short cut keys such as “Ctrl + 

A” or “Shift or Ctrl + left mouse button” you may select all or multiple scans for opening them. 

Now you are ready to familiarise with the user interface and to try out the first functions such 

as the distance measurement. 

3.2 The user interface 

In this chapter you will get to know the user interface of VirtuSurv with its different 

components. 
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3.2.1 The menu bar 

As usual you will find the menu bar in the top area. It contains in four menus, all of the 

general VirtuSurv commands. 

In the "File" menu you will find commands for opening, importing, saving and creating 

projects. The "Measure modes" menu provides all commands for the measurement and 

evaluating the scans. Via the "View" menu you may control the display of the tool-bars as 

well as the arrangement of the scan windows. You will also find a button for closing all scan 

windows. In the "Help" menu you will find a link to the manual, information regarding 

VirtuSurv, the licence manager for the licence configuration and a link to the download page 

for sample files and additional useful macros. 

3.2.2 The tool-bars 

For fast access, the tool-bars with the most important general commands have been placed 

directly underneath the menu bar. You may show or hide these via the "View" menu. You 

may also release the tool-bars from the upper frame and place them floating or attach them 

to any other frame. To do so simply move the mouse over the point line at the left edge of a 

tool-bar, when the cursor turns into a cross of arrows, press and hold down the left mouse 

button until you have moved the bar to the desired position. 

3.2.3 The Project Explorer 

The Project Explorer is situated left of the main window. The scan project that has been 

loaded and its single scans are listed here in a structure view. Only one project can be 

opened at a time. Single scans always belong to a project. 

When selecting a scan in the Project Explorer (click with the left mouse button) the 

corresponding scan view is activated in the working window and where applicable put to 

front. The active scan will also be highlighted in the scan map. 

By clicking the right mouse button you can open context menus with project-specific, scan 

related or view related commands. Following, these context menu commands are explained 

briefly. 
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Context menu of the project 

 

The context menu of the project contains 

the commands for saving and closing the 

project as well as for adding scans, 

which can likewise be found within the 

"File" menu. Furthermore you can check 

the project properties (project name, 

path and number of scans) and export 

the complete project into one or several 

point clouds (LAS, PTS or PTC). You can find more information regarding exporting to point 

clouds in chapter 3.7 . 

With “Add Scans” you may add multiple single scans that already exist in VirtuSurv format to 

your project. A dialogue box opens. There you click the [Add scans from directory] button and 

simply browse to the directory where the scans you want to add are stored. VirtuSurv will list 

all single scans it found there. You may now select all or just some of the scans and add 

them to your new project by clicking [OK]. 

With “Export Scan Positions” the scan positions of the whole project can be exported to a 

TXT or CVS file. This export is matched to be used in combination with FARO PointSense 

and As-Built products, but it is also helpful for creating a scan map outside VirtuSurv. 

  

Context menu of a scan 

 

The context menu of a single scan 

contains commands for saving and 

removing a scan from the project. You 

can check the properties of the particular 

scan. You can export the complete scan 

or marked parts of it into a point cloud file 

(LAS, PTS or PTC) with the export 

command. You will find more information 

regarding this command in chapter 3.7 . 

The most important commands in the context menu of a scan are the ones to open the scan 

in a certain display mode. You may select one of the following display modes: 



VirtuSurv 

 | 15 

 

Clicking on one of these entries opens the scan and shows it correspondingly in the scan 

view window. 

Hint: With short cut keys such as “Ctrl + A” or “Shift or Ctrl + left mouse button” you may 

select all or multiple scans for opening them. 

Context menu of a scan view 

The context menu of a scan view includes the command for closing the view and – as long as 

it is not a true colour view – the histogram stretching command. 

  

3.2.4 The scan map 

The scan map is placed below the Project Explorer. It shows the distribution of the scanner 

positions. 

In the scan map you may zoom with the help of 

the mouse wheel and pan the view by pressing 

down the mouse wheel. 

Via the pulldown menu to the left above the 

scan map you may switch from the top view to 

another view. This is useful for projects, where 

the scans are not only spread horizontally but 

also vertically. 

The active scan is highlighted. Click on a scan 

to put it to front in the working window or to 

open it. 

For all scans opened in a view window the 

currently visible area is outlined in the scan 

map. 
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3.2.5 The working window 

The working window is the central element of the user interface of VirtuSurv. The scans for 

evaluating are displayed here. Via the context menu of the scan you determine how it shall 

be displayed (see chapter 3.2.3 ). 

When several scans have been opened you may arrange the scan view windows manually or 

- with the help of these buttons  - automatically. If the full screen mode is active, use 

the scan map or the Project Explorer for putting the desired scan forward. 

Use the mouse wheel in order to zoom in or out. For panning press down and hold the 

mouse wheel. The mouse pointer will turn into a hand. If, for any reason, the pan function of 

your mouse should be inactive, please use the Ctrl + right mouse button instead. 

You may change the size of the working window to the left, right, top or bottom. Move the 

mouse over the according grey edge until the mouse pointer changes . Then press down 

the left mouse button and move the edge to the desired position. 

3.2.6 The protocol window 

Measured distances and coordinates are displayed in the protocol window. Macros used for 

the measurements are also recorded here. 

3.2.7 The status bar 

The status bar is placed at the lower edge of the VirtuSurv window. On the left you see which 

measure mode is active at the moment. Information regarding the current view mode of the 

currently active scan can be seen at the very right. 

3.2.8 Windows for macros and special commands 

In addition to the so far described components of the user interface, windows for macros and 

special commands are opened according to the selected measurement or evaluation mode. 

By default these are attached to the right edge of the VirtuSurv window, but they may be 

detached from the edge and moved to another position manually. This is especially useful for 

users working with two screens. 

In chapter 3.3  the different windows for macros and special commands are described in 

detail. 
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3.3 Evaluating with VirtuSurv 

This chapter introduces you to the possibilities for the evaluation of 3D laser scan data with 

VirtuSurv. Please feel free to use the sample data set, which you have opened according to 

chapter 3.1  of this manual. 

Before the functions are explained in detail you will get some general information. 

3.3.1 Measurement unit, accuracy, etc 

When importing scan data (see chapter 3.6 ) you will have to enter in which unit of length you 

have scanned. Independent of this scan unit at import, you can state the measurement unit 

which you want to use for the measurements in VirtuSurv. VirtuSurv will automatically convert 

all measurement values into this unit. 

Use the "Configure Measurement Unit"  command from the "Measure mode" menu in 

order to set the measurement unit. The following dialogue box opens, next to the unit you can 

state the display accuracy, the decimal separator and also the thousands separator here. 
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The settings which you set here will affect all measurement modes. When sending the 

measured values to AutoCAD (LT) or BricsCAD always the maximum measurement 

accuracy is transferred. 

Important information: 

The accuracy of the evaluation of scan objects depends on the quality of the scans that 

means, from their resolution, the quality of the registration as well as the quality of the 

colouring of the scans with RGB colour values. Especially when colouring the scans, the 

results of the scanner manufacturers are very different regarding the quality. Therefore we 

recommend to switch from the attractive true colour (RGB) display to the display of intensity 

values in grey scale when the measurement accuracy is especially important during the 

evaluation. In order to switch the display mode for a scan, go to the Project Explorer move 

to the context menu of the scan and select the desired view. If you would like to adapt 

brightness and contrast move to the option "Histogram stretching" via the context menu of 

the scan view. (See chapter 3.2.3 ). 

If highly reflective surfaces have been scanned too, the coordinates, which are measured 

on these surfaces, are often wrong, since the distance measurement of the scanner provides 

falsified values for such surfaces. You will be able to recognise reflecting surfaces in the true 

colour view and the intensity view, but not, whether the distance measurement of the scanner 

is incorrect. You can only see that in the distance colouring view. Switch to the distance view 

if you are unsure whether measurements on reflecting surfaces are still providing correct 

results. If there are colour or grey scale bounds distinguishable in the continuous surface you 

should not take any measurement values from this surface. 

If you measure in the true colour view and do not get a measurement value for the clicked 

point then the reason for this is that there is image information from photos but no object data 

for this point. That happens, for example, for highly absorbent surfaces, which swallow the 

laser signal, for the sky or for distant points, which lie outside of the scan range. In the 

distance view such areas without scan information are immediately visible as gaps in the 

image. 

Hints: 

Measured points are labelled by a marker (cross) in the scan. The appearance of the marker 

illustrates with the help of which measurement tool the respective point has been measured. 

With the "Configure Markers"  command from the "Measure mode" menu you may 

determine the size, the start value for numbering the markers as well as the font size and 

colour of the point numbers: 
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Caution: When you enable the “display markers in all scans” option the performance of 

VirtuSurv may slow down. The setting will only be valid for the points clicked after enabling. 

After taking many measurements the number of markers in the scan view could become very 

large and clarity gets lost. Use the "Delete Markers"  command from the "Measure mode" 

menu in order to delete all markers from the scans. 

If you want to finish a measurement mode without activating another measurement mode, 

simply click the  button in the tool-bar or in the "Measure mode" menu. 

3.3.2 Measuring point coordinates 

If you want to know the coordinates of one or a few points just for informational reasons run 

the "Get Coordinates"  command from the "Measure mode" menu and click the desired 

point/s in the scan. The clicked points are marked  and the according coordinates are 

displayed in the protocol window. 

 

You may change the measurement unit and the accuracy of the display with the "Configure 

Measurement Unit"  command. (See chapter 3.3.1 ). 

If you want to generate a coordinate list for further application, it is best to use one of the 

provided "Send to Windows" macros , e.g. . You find detailed information regarding 

these macros in chapters 3.3.4  and 3.4 . 
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Do you have a CAD system that can generate a drawing with the help of coded points? 

Please refer to chapter 3.3.10 in order to learn how to generate a coded coordinate list with 

VirtuSurv. 

3.3.3 Measuring distances 

You want to take a distance from a scan, quickly? Run the "Get Distance"  command 

from the "Measure mode" menu. Then click the end points of the distance to be determined. 

The clicked points and the connecting line will be marked and the slope distance as well as 

the horizontal and vertical distance of the points is displayed in the protocol window: 
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You may change the measurement unit and the accuracy of the display with the "Configure 

Measurement Unit" command . (See chapter 3.3.1 ).  

Hint: 

You may measure the width and height of a window with only one measurement (two clicks), 

by clicking the end points of the window diagonal. Simply try it. 
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You would like to use the measured distances in other Windows programs, e.g. in order to 

sum them up or to fill in forms? Please refer to chapters 3.3.4  and 3.4  in order to learn how 

to use provided macros and your own customised ones. 

3.3.4 Filling in forms, tables, data bases, etc 

Use the "Send to Windows" command from the "Measure mode" menu if you want to get 

coordinates of discrete points such as: 

 Excavation finds (archaeology), 

 Trees for the tree cadastre 

 Connection points of industrial plant components 

 Power sockets, signs, hydrants, telephone booths, etc. 

or distances such as: 

 Width and height of windows, doors, etc. 

 Clearances, spaces 

 Wall lengths etc. 

from your scan project and transfer them into an information system, into lists, tables or 

forms. To the right of the VirtuSurv scan window the macro bar for sending to Windows 

applications opens. You may move the bar and attach it to any other edge. In order to do so 

click and hold the left mouse button on the head of the bar until you have moved the bar to 
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the desired position. The macro bar may be closed via the cross in the top right corner of the 

window or by clicking on the  button in the tool-bar. 

VirtuSurv provides several predefined macros: 

 

Before you can use the macros, you have to connect VirtuSurv with the Windows application 

to which you want to transfer the measurement values. Open the target program first. Then 

click on [Connect…] in the VirtuSurv macro bar. The following dialogue opens: 
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Move the mouse over the cross hairs ("Finder Tool"). Click and hold the left mouse button. 

Drag the cross hairs into the window, into which you would like to transfer the VirtuSurv 

measurement values. The recognised application is displayed in the dialogue box. Release 

the mouse button. VirtuSurv now reports successful connection. 

You start a macro by clicking on the appropriate button in the macro bar. Then click the 

points or distances in the scan which you would like to evaluate. You finish a macro by 

clicking its button again. 

  

Examples: 

Sending coordinates to Excel: 

Open an empty Excel table. In VirtuSurv run the "Configure Measurement Unit"  command 

and set the desired measurement unit, e.g. metre. Make sure that the decimal separator has 

been set to the same as used in Excel. 

If you have not already done so open the macro bar by clicking on "Send to Windows" . 

Then go to [Connect…] and drag the cross hairs into the Excel window. Now VirtuSurv and 

Excel are linked. Start the macro by clicking the  button in the macro bar. Now, the 

coordinates of the points that you click on in one or several scans are written into the Excel 

table: 

 
 

You finish the macro by clicking the  button again. 

  

You finish the macro by clicking the button again. 

Open the text file and in VirtuSurv the scan project with the windows that are to be measured. 

Connect VirtuSurv with this file as described above. Start the macro for the sending the 

horizontal and vertical distances . Click the ends of the window diagonals in order to 

determine the width and height with only two clicks per window and to write them into a text 

file. 
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You finish the macro by clicking the  button again. 

If you would like to measure the distances in millimetres instead of metres, use the 

"Configure Measurement Unit" command , that is described in detail in chapter 3.3.1. 

  

Summing up distance lengths 

You may also send distance lengths to the Windows calculator and add them up or subtract 

them from each other. In order to do so start the Windows calculator and link it to VirtuSurv 

as described above. Make sure you have set the desired measurement unit. 

  

Try out the different macros with the sample project you have downloaded in chapter 3.1 or 

with your own scans. 

In chapter 3.4 Optimised evaluation – customised macros, you will learn how to 

customise macros and create your own. 

3.3.5 Sending observations to the clipboard 

With VirtuSurv you can send direct to the clipboard coordinates of discrete points or 

distances you have obtained from your scan project and then with Ctrl+V insert them back 

into any Windows application. In this way, other than with the other measurement modes, 

observed data can also be inserted into dialogue windows within the program. This is an 

extremely flexible function.  

“Send to clipboard” is started from the "Measure mode" menu (under “Send to other 

systems”). On the right hand side of the VirtuSurv window the macro bar opens with the 
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macros for sending information to Windows clipboard. You may move the bar and attach it to 

any other edge. In order to do so click and hold the left mouse button on the head of the bar 

until you have moved the bar to the desired position. The macro bar may be closed via the 

cross in the top right corner of the window or by clicking on the  button in the tool-bar. 

VirtuSurv provides several predefined macros: 

 

You start a macro by clicking on the appropriate button in the macro bar. Then pick the points 

that you need in the scan, switch to the target program of your choice, click in the desired 

dialogue field and insert the measured value using Ctrl+V.  

You finish a macro by clicking its button again. 

In chapter 3.4 Optimised evaluation – customised macros, you will learn how to 

customise macros and create your own. 

3.3.6 Drawing with any CAD system 

VirtuSurv enables you to directly draw in CAD systems using the points and distances you 

measure in the scan project, without having to load the large ponderous data sets as point 

clouds into your CAD system. This way you can even evaluate laser scans in CAD systems 

that do not support point clouds. 

As described in chapter 3.3.4 VirtuSurv can be connected to any CAD system, which is 

capable of receiving data by "copy and paste" – usually those CAD systems do have a 

command line (e.g. Rhinoceros 3D, IntelliCAD, etc.). In order to draw, you start the relevant 

command within the CAD system. The command will generally expect the coordinates of a 

point as input. In VirtuSurv you start a macro which provides the point coordinates in the 

format expected by your CAD system and click the respective point in the scan. This way you 
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can draw ground floor plans, views and sections in CAD and model them in 3D. Even 

drawing commands, that expect distance lengths as input can be "fed" with the measurement 

data from VirtuSurv. 

The following two predefined macros for sending coordinates into CAD systems are delivered 

with the “Send to Windows” macro bar . 

 

Caution! The coordinates will not be converted into the user coordinate systems, since there 

is no bidirectional connection into the CAD system. 

We provide further useful macros on a special website which you can access via the 

"Download Examples & Macros" entry from the “Help” menu or the  icon within the tool-

bar. 

In chapter 3.4 Optimised evaluation – customised macros, you learn how to customise 

macros and create your own. 

  

Tutorial – Modelling with VirtuSurv and Rhinoceros 3D 1 

This tutorial explains how you can use VirtuSurv together with Rhino 3D for constructing 

geometric objects directly from the laser scan data. The macros provided speed up the 

processing in Rhino and exemplary demonstrate the versatility of the VirtuSurv macro 

system. 

Opening the scan project: 

Please load the sample project from the VirtuSurv web site and open it, if you have not done 

so already. In chapter 3.1 you will find instructions for doing so. 

Open the true colour views of scan 3 and scan 5 from the Example02_kubit_house project 

and change the scan window to full screen. By selecting it in the structure view of the Project 

Explorer you must ensure scan 3 is at first in front. With the mouse wheel zoom out, so that 

preferably the complete living room is visible in the scan window (scan_003). 

Use the "Send to Windows" command from the "Measure mode" menu or click on the  

icon for sending information to Rhino. To the right of the VirtuSurv scan window the macro 

bar for sending to Windows applications opens. 

  

Importing the macros: 
                                                      
1Rhinoceros (Rhino) is a product of Robert McNeel & Associates. www.rhino3d.com 

http://www.rhino3d.com/
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VirtuSurv is shipped with some predefined macros for sending coordinates and distances e.g. 

to Excel (see chapter 3.3.4). We have also prepared some special macros for working with 

Rhino. You can find these macros on our web page, which you can access by clicking the 

button in the “Help” menu or in the VirtuSurv tool-bar. Please, download the 

MACROS_FOR_RHINO.ZIP file. Save it to your computer and uncompress it. Then copy the 

“RHINO MACROS.TXT” file and the “MacroImages” folder from the folder 

“Macros_for_Rhino” to your VirtuSurv application data folder. Usually you will find the 

application data folder here: 

„C:\Users\{username}\AppData\Roaming\FARO\VirtuSurv_{versionsnummer}“ 

To import the Rhino macros click [Import Macros] in the lower part of the macros bar. Then 

browse to “RHINO MACROS.TXT” and click [Open]. 

The following dialogue box opens: 

 

On the left you find the list of the macros for the import, contained in the TXT file, on the right 

the list with the macros already existing in VirtuSurv. Select the macros you would like to 

import and then click [Import >]. With [Import all] you can import all macros at once. 

When you have made your choice for the import, confirm with [OK]. The predefined Rhino 

macros are now shown in the macros bar. You may now delete the other Windows macros 

you do not need, gaining more clarity. To do so, right-click the macro button and select 

“Delete the macro” in the context menu. 

The VirtuSurv macros bar should now contain following buttons: 



VirtuSurv 

 | 29 

 

  

Connecting with Rhino: 

In the next step VirtuSurv will be connected to Rhino. First start Rhino and open “Large 

projects – metres” as the template. Rhino version 5.0 was used for this tutorial. 

To get a better overview of both programs we recommend minimising the program windows 

to half the screen width and arranging them side by side. 
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For sending the coordinates to Rhino with the correct units VirtuSurv has to be configured the 

same as the Rhino settings. In our example we work in metres in Rhino. In VirtuSurv use the 

“Configure Measurement Unit” command  and configure there the units as you want them 

to be. (See also chapter 3.3.1). Now also check the unit settings in Rhino at “File Properties 

Units”: 

 

Now also check the unit settings in Rhino at „File  Properties  Units“: 
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Before you can use the macros, you have to connect VirtuSurv with Rhino. Just click on the 

[Connect…] button in the VirtuSurv macro bar. The following dialog opens: 

 

Move the mouse over the cross hairs ("Finder Tool"). Click and hold the left mouse button. 

Drag the cross hairs into Rhino’s command line. The dialogue box confirms Rhinoceros has 

recognised application. Release the mouse button. VirtuSurv now reports successful 

connection. 

VirtuSurv has now been prepared to send coordinates and commands to Rhino. For a first 

test select the point macro  from the VirtuSurv macros bar and click any point in the scan 
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view with the left mouse button. VirtuSurv now sends the “Point” command followed by the x, 

y, z coordinates to Rhino, which then draws the according point. 

  

Rhinoceros macros overview: 

The pre-defined Rhino macros are divided in two classes: 

1. Macros for sending coordinates or distances 

2. Macros for starting Rhino commands 

The first class can be used whenever Rhino demands a point or a distance as input. The 

second class does not only send the coordinate of the point clicked in VirtuSurv but at the 

same time sends a command or even a command option to the Rhino command line. 

Following table lists all pre-defined macros: 

Macro 
Usage 

Remarks 

Macros for sending coordinates or distances 

w XYZ 

Click point in scan 

Sends x, y, z coordinates as 

world coordinates 

  

w XYZ 

[enter] 

Click point in scan 

Sends x, y, z coordinates as 

world coordinates followed 

by [Enter] 

The [Enter] at the end simultaneously closes the current 

Rhino command 

XY 
Click point in scan 

Sends x, y coordinates 

The coordinates refer to the current Rhino construction 

plane. 

Caution! The global coordinates of VirtuSurv will not be 

converted into the coordinates of the current construction 

plane. This macro should only be used together with 

construction planes that have been created by shifting 

the world coordinates along the z-axis. 

XY [enter] 

Click point in scan 

Sends x, y coordinates 

followed by [Enter] 

Also see macro “XY” 

The [Enter] at the end simultaneously closes the current 

Rhino command 
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Macro 
Usage 

Remarks 

w xy0 

Click point in scan 

Sends x, y coordinates and z 

= 0 as world coordinates 

This macros is used in combination with the command 

“Construction plane by 3 points” 

vertical 

dist 

Click two points in scan 

Sends vertical distance 

between both points 

  

horizontal 

dist 

Click two points in scan 

Sends horizontal distance 

between both points 

  

Macros for starting Rhino commands 

 

Click point in scan 

z-coordinate defines height 

of a new construction plane 

Current construction plane will be aligned with the world 

coordinates. Origin of the new construction plane is 0,0,z 

 

Click point in scan 

Starts the command 

“Construction plane by 3 

points” 

Afterwards use [w xy0] and click the second point in 

direction of the x-axis. Then use [w XYZ] and click the 

third point. The construction plane is created in a way the 

x-axis lays in the xy-plane of the world coordinate 

system. 

 

Click point in scan 

Draws a point at x, y, z 
  

 

Click point in scan 

Starts the “Polyline” 

command 

Afterwards use [XY] to click further points and [XY 

[enter]] for the last point and finishing the command. The 

polyline is drawn on the XY plane of the current 

construction plane. 

Caution! The global coordinates of VirtuSurv will not be 

converted into the coordinates of the current construction 

plane. This macro should only be used together with 

construction planes that have been created by shifting 
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Macro 
Usage 

Remarks 

the world coordinates along the z-axis. 

 

Click point in scan 

Starts the “Polyline” 

command 

Afterwards use [w XYZ] to click further points and [w XY 

[enter]] for the last point and finishing the command. 

 

Click point in scan 

Starts the “Rectangle” 

command with the “3 points” 

option 

Afterwards use [w XYZ] and click the second point on the 

end of the edge. Then use [w XYZ] and click the points 

to define the width. 

 

Click point in scan 

Starts the “PlanarFace” 

command with the “3 points” 

option 

Afterwards use [w XYZ] and click the second point on the 

end of the edge. Then use [w XYZ] and click the points 

to define the width. 

 

Click point in scan 

Starts the 

“PlaneThroughPoints” 

command 

Afterwards use [w XYZ] and click three further points or 

finish the command with [w XYZ [enter]] after the third 

points. 

  

Using the Rhino macros 

You have already tried a simple macro when sending a point to Rhino. In the following 

paragraphs it will be shown how to combine various macros for Rhino. 

Select the  (3D Polyline) macro from the VirtuSurv macros bar and click any point in the 

scan to run the command. For drawing the window outline select the “w XYZ” macro and click 

the points you need in the scan. You may also open several scans at once and click the 

coordinates in different scans if needed. The macro is active until you click on its button again 

or select another macro. To finishing the polyline use the [w XYZ [enter]] macro or switch to 

Rhino and finish the command there by pressing [Enter]. You should now see a similar result 

as shown in the figure below. 
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Check for videos on  andhttps://youtu.be/igp4FUjdKtc. 

Do you want to run more drawing commands directly from VirtuSurv? In chapter 3.4 you 

learn how to generate your own macros. 

3.3.7 Drawing with SEMA 

VirtuSurv provides a direct connection for users of the timber construction CAD system 

SEMA. To connect VirtuSurv with SEMA go in the “Measure mode” menu to “Send to other 

systems” and click there on “Send to SEMA”: 

 

To be able to receive data from VirtuSurv in the SEMA software, you must have purchased 

and activated a SEMA licence for the bill of quantities module. 

If the connection between VirtuSurv and SEMA has been established, simply start the 

drawing command of your choice in SEMA and then pick the points in the scan in VirtuSurv 

that you need for your construction. 

The transfer of the survey points from VirtuSurv is integrated into the SEMA program in the 

form of a “3D mouse”. In every situation in SEMA where you would normally define a point by 

a mouse click in the drawing, you can select a point in the VirtuSurv scan. The coordinates 

will be transferred to the construction command in SEMA. 

It is recommended to open both programs next to one another. 

https://youtu.be/igp4FUjdKtc
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Example: Enter a wall over two points. 

You will be prompted on the SEMA input line to enter two points (“from point”, “to point”). 

That is usually done by a mouse click on an object in the drawing window. In this example 

you define the desired points by clicking on existing walls in the VirtuSurv scan. 

To be able to send the coordinates to SEMA in the correct units, the VirtuSurv settings have 

to be configured in the same way as the SEMA settings. In VirtuSurv use the “Configure 

Measurement Unit” command  and configure there the units as you want them to be. (See 

section 3.3.1). 

3.3.8 Drawing with AutoCAD (LT) 

VirtuSurv provides a special macro system for evaluating with AutoCAD and AutoCAD LT. In 

this way it is especially comfortable for AutoCAD users to draw and model. You may run the 

drawing commands directly from VirtuSurv and do not have to switch between VirtuSurv and 

AutoCAD. Besides that, the connection to AutoCAD and AutoCAD LT is established 

automatically. 

And this is how it works: 

Open the macro bar for the transfer to AutoCAD and AutoCAD LT by running the "Send to 

AutoCAD (LT)" command from the "Measure mode" menu. The connection to AutoCAD is 

established at the same time. 

The AutoCAD macro bar is being opened on the right hand edge of the VirtuSurv window. 

You may move the bar and attach it to any other edge. In order to do so click and hold the left 

mouse button on the head of the bar until you have moved the bar to the desired position. 

The macro bar may be closed via the cross in the top right corner of the window or by clicking 

on the  button in the tool-bar. 

VirtuSurv provides several predefined AutoCAD macros: 
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You start a macro by clicking on the appropriate button in the macro bar. Then, in the scan, 

click the points you need to draw. You finish a macro by clicking its button again. 

  

Tutorial – drawing the outline plan of a room in AutoCAD 

Please load the sample project from the VirtuSurv web site and open it, if you have not done 

so already. In chapter 3.1   you will find instructions for doing so. 

Open the true colour views of scan 3 and scan 5 from the Example02_kubit_house project 

and change the scan window to full screen. By selecting it in the structure view of the Project 

Explorer you must ensure scan 3 is at first in front. With the mouse wheel zoom out, so that 

preferably the complete living room is visible in the scan window (scan_003). 

Start AutoCAD and open a new empty drawing. 

Open the AutoCAD macro bar in VirtuSurv by running the "Send to AutoCAD (LT)" 

command from the "Measure mode" menu. Click on the  button in order to start the macro 

for drawing lines. Now click two points on every wall as follows in order to draw the outline 

line of the living room in AutoCAD. Ensure that you do not click directly in the corners; such a 

measurement would be too inaccurate. You will generate the correct sharp corners later on in 

AutoCAD. 
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Then continue with the separating wall at the stairs. 

 

Then proceed clockwise: 
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Now change to scan 5, by selecting it in the Project Explorer. Then zoom to the small part of 

the wall which separates the sitting area from the niche of the staircase and click two points 

on this narrow area. 

 

Follow the run of the wall in the niche of the staircase: 
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Being still in scan 5, leave the niche of the staircase: 

 

Remember to click the wall surface close to the corners not directly in the corners or on the 

edges. 

To follow the run of the wall into the kitchen, change back to scan 3 by selecting it in the 

Project Explorer. Now move the view in the scan window (hold down mouse wheel or Ctrl + 

right mouse button), so you can see the kitchen area. Now click the next wall point: 
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Point 23 is the first point on the last wall. The scan is an all around scan (360°) and it has 

been unpicked on the last wall for creating the planar view. Therefore you have to zoom out, 

pan the view to the left part of the scan and zoom onto the corner with which you have 

started to draw the outline of the living room in order to measure the second point on the last 

wall: Now click point 24. 
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You finish the line macro and at the same time close the line run by right clicking in the scan. 

After "Zoom to extents"  you will see the outline of the living room which you have just 

drawn with VirtuSurv. 

Note: If you want to finish a line run without closing it, just click again on the macro button . 

This will finish the line macro. For finishing the line command in AutoCAD you click the 

“ENTER” button  in VirtuSurv. You do not have to switch to AutoCAD for this. 
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So far, the corners are cut off and the lines are positioned on the height, measured in the 

scan. You level the lines by selecting them all and setting the Z values of the starting points 

and end points to zero in the properties window. 

Hint: If you adapt the line macro so it will draw 2D instead of 3D you will not have to level the 

lines afterwards. You learn how to do that in the next chapter. 

Now the corners have to be sharpened. In order to do so, use the AutoCAD command 

FILLET with the following settings: 

Current settings: Mode = TRIM, radius = 0.0000 

Select the wall lines that run towards the corner when you are asked for the first and the 

second object. Lastly, delete the short sloped line segments. With this the floor plan has been 

corrected. 

If you use AutoCAD plug-ins from FARO or kubit, e.g. As-Built, TachyCAD or PointSense, 

thanks to the provided special commands, you draw far more efficiently, since you do not 

have to sharpen the corners manually. 
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Using the line macro you can also draw the staircase and the run of the ceiling beam. To do 

so, choose the suitable scans. Unfortunately there is no scan available for the upper part of 

the staircase. 

In completion of this tutorial there are blocks to be inserted into the floor plan at the positions 

of the ceiling lamps. At first generate the block in AutoCAD. Draw two concentric circles 

("Circle" command and "Centre" object snap). 

 

Then run the BLOCK command. Assign a name to the block (e.g. lamp) and determine the 

insertion point, by clicking the "Pick point" button and then snap the centre of the circle in the 

drawing. Via the "Select objects" button you assign the two circles that you have just drawn 

to the block. 

 

The block will be defined in the drawing when you press the [OK] button. 

Start the "Insert" command of AutoCAD. 

Resources
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Now select the name of the block definition you have just generated. The other options 

should be set as can be seen in the above screen shot. Confirm with [OK]. Now AutoCAD 

expects the input of a set of coordinates for the insertion point. 

Change to VirtuSurv. Start the macro for sending 3D coordinates to AutoCAD . Activate 

scan 3. Zoom to the lamps in the sitting area and click on the socket of the first ceiling lamp 

and about in the middle of the lamp chimney. 

 

The coordinate of the clicked point is transmitted to AutoCAD and the block is inserted into 

the drawing at that exact position. 

Start the "Insert" command of AutoCAD again and repeat the sequence for the remaining 

lamps. 

The result of the exercise should look like this: 
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Windows and doors can be drawn and dimensioned more efficiently when using special 

commands. FARO or kubit offer different AutoCAD plug-ins for this. When using those you 

run the according command and measure the needed points with VirtuSurv. 

  

Do you want to run more drawing commands directly from VirtuSurv? In chapter 3.4   you 

learn how to generate your own macros. 

  

Hint: We have prepared further useful macros (e.g. for drawing 2D). You find these macros 

on our webpage which you can access by clicking the  button in the “Help” menu or on the 

VirtuSurv tool-bar. In Chapter 3.4.4 you learn how to import these macros. 
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3.3.9 Drawing with BricsCAD 

VirtuSurv provides a special macro system for evaluating with BricsCAD. In this way it is 

especially comfortable for BricsCAD users to draw and model. You can run the drawing 

commands directly from VirtuSurv and do not have to switch between VirtuSurv and 

BricsCAD. Besides that, the connection to BricsCAD is established automatically. 

And this is how it works: 

Open the macro bar for the transfer to BricsCAD by running the "Send to BricsCAD"  

command from the "Measure mode" menu. The connection to BricsCAD is established at the 

same time. 

The BricsCAD macro bar is being opened on the right hand edge of the VirtuSurv window. 

You may move the bar and attach it to any other edge. In order to do so click and hold the left 

mouse button on the head of the bar until you have moved the bar to the desired position. 

The macro bar may be closed via the cross in the top right corner of the window or by clicking 

on the  button in the tool-bar. 

VirtuSurv provides several predefined BricsCAD macros: 

  

 



48| 

You start a macro by clicking on the appropriate button in the macro bar. Then, in the scan, 

click the points you need to draw. You finish a macro by clicking its button again. 

If you want to practice working with VirtuSurv and BricsCAD, you may download example 

data from the VirtuSurv example web page and open it. In chapter 3.1 you will find 

instructions for doing so. Then just follow the tutorial provided for AutoCAD (LT) (on page 

37ff). 

Do you want to run more drawing commands directly from VirtuSurv? In chapter 3.4 you 

learn how to generate your own macros. 

3.3.10 Creating a coded field book 

With the function for creating a coded field book, VirtuSurv takes on the established role of 

the surveyor. It addresses users who have, so far, observed their objects coded with a total 

station, in order to automatically generate a finished drawing with the help of the codes when 

importing the measurement data into their CAD system. Now these users may also use laser 

scanner data in order to create their coded point lists, their field book. 

In this chapter you will learn, with the help of a notional example, how to generate, transfer 

and edit your code list. You will learn how to use the code list, in order to create a coded field 

book. And you will learn how to configure, edit and save the field book. 

Please note that this function is only of use for you, when your CAD system comes with a 

function for importing coded data. Please use those codes, that your CAD system needs for 

the drawing and which fit your field of application. 

Run the "Create Field Book"  command from the "Measure mode" menu under "Send to 

other systems". The task bar for the generation of a coded field book opens at the right hand 

edge of the VirtuSurv window. You may move the bar freely or attach it to the left hand edge. 

In order to do so click and hold the left mouse button on the head of the bar until you have 

moved the bar to the desired position. The task bar can be closed via the cross in the top 

right corner or by clicking  in the tool-bar. 
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Creating a code list 

To generate a code list, you may simply enter your codes into the relevant field. They will be 

added to the code list. If you want to create a larger code list with code groups and a 

description for every code, click the [Create/edit code list...] button. The following dialog 

opens: 
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You may enlarge the window to get an overview of the list without having to scroll a lot. 

The upper part contains the list of defined codes. At the moment this is empty. Every code 

will be assigned to exactly one code group. The description helps the user to understand the 

often cryptic code and to select the correct point code when measuring points. 

Click the [New code] button in order to add a new code to the list. A new line will be added to 

the list (at the lower end). 
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To enter or edit a code, double click into the code field and enter the code. The entry of the 

description works analogue. You may either enter a new code group or select one from the 

list of code groups. 

Simply try it. Use the codes, which you use for your total station survey! (The example in this 

manual is only notional). 

 

 

VirtuSurv allows codes which are composed of a string of digits or letters or a combination of 

both. The CAD software Geograf for example expects point codes which consist of four 

digits.  

The codes do not only control what will be drawn in your CAD system but also how it will be 

displayed (line width, symbols, hatches, etc.). 

No code or description are allowed to be assigned twice. VirtuSurv checks this and secures 

this uniqueness by warning the user: 

 

You may generate different code lists for different tasks. If you have entered all codes you 

need, save the code list by clicking [OK]. [Cancel] drops your changes in the code list 

If you want to delete a code from the list, select the code and click the [Remove selected 

code] button. You may also select several codes to be deleted by using the Ctrl or Shift keys. 
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Export your code list, generated in VirtuSurv, in order to be able to use it on all of your 

computers, or to keep it when installing a VirtuSurv update. Click on [Export code list…] 

and save the list with a meaningful name. Copy the exported code list file to the new 

computer. There start the "Create Field Book"  command from the "Measure mode" menu 

in VirtuSurv. Click on the [Create/edit code list…] button and then on the [Import code list…] 

button when in the code list window. Select the code list file to be imported. Now you can use 

the codes here as well. 

  

Using the code list – create field book 

When you have defined the code list as described above, you can now use it for creating a 

coded field book when measuring in the scan project. 

At the very top of the field book task bar, enter the point ID of the point to be measured and 

define the increment. After measuring the point (by clicking in the scan) the next point 

number is displayed, according to the increment. Enter a negative increment if the 

measurement points are to be counted downwards from the starting point number. 

Select the desired code from the list, before measuring the point. Via the code group list, you 

may pre-filter the codes and then get only the codes belonging to the code group. The 

description for the selected code is displayed too. You may enter any comment in the 

"Comment" field. Of course you may also select a code by its description. 

 

After you have selected point number and code, click the point to be measured in the scan. It 

will be written to the field book with its coordinates and the code. 

To view, edit and save the field book click the [Open field book…] option. The field book will 

be opened: 
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You may enlarge the window to get an overview of the list without having to scroll a lot. You 

may sort the field book by columns by clicking the according column header. 

Measurement unit, display accuracy and decimal separator must agree with the settings 

under "Configure Measurement Unit"  from the "Measure mode" menu. Make sure to set 

the correct unit before you start measuring! 

By default the point ID, the point code, the point coordinates and the measurement units are 

displayed in the field book. If you want to display and save the description and the comment 

for every point or change the order of the columns in addition to the above, click on 

[Configure…]. The following dialogue box opens: 

 

Make sure, the coded field book has a format which can be imported from your CAD system. 
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If you want to delete single points from the field book, select them and click on [Remove 

selected row]. You may also select several codes to be deleted by using the Ctrl or Shift 

keys. 

With the [Cancel] button you close the field book and discard all changes. With [OK] all 

changes are adopted upon closing. 

When you have measured everything that has to be drawn afterwards in the CAD system, 

click on [Save to file], in order to save the field book to a text file. After you have entered a 

name for the field book file and clicked on save, a dialogue box with the preview opens, 

where you may determine the separator for the columns: 

 

By clicking [Write] the field book file is written. Since it is a text file, it may be opened and 

edited with a text editor at any time. 

Make sure, the coded field book has a format which can be imported from your CAD system. 

  

Important note: 

VirtuSurv continues to write to the existing field book until the user clears it with the [Clear 

field book] button. Newly measured points are added at the end. When you have finished a 

measurement project, save it with [Save to file] and then clear the field book before creating 

the next field book. 
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3.4 Optimised evaluation – customised macros 

You are already familiar with the advantages and the use of VirtuSurv macros in chapters 

3.3.4 to 3.3.9. Laser scan data are gathered and evaluated for many different tasks/results. 

Therefore VirtuSurv provides functions, so that you may optimise the software for your own 

special tasks. In this chapter you will learn how to customise the predefined macros and 

create new macros with the help of the macro editor. 

There are two kinds of macros in VirtuSurv: 

  one type of macro is for the structured sending of measurement values (coordinates 

or distances) to any Windows application, such as Excel, data bases, any CAD software, 

  on the other hand special macros for the sending to AutoCAD (LT) or BricsCAD, 

where not only measurement values can be transferred but also CAD commands can be 

started and controlled. 

There are separate macro bars for the different macro types. Layout and handling of the 

macro bars are analogue. The buttons with the predefined macros are in the upper part, the 

buttons for the creation of new macros and for the import and export of macros are in the 

lower part. 

  

Resources
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3.4.1 Customise predefined macros 

To customise an existing macro, right-click, in the macro bar, on the macro button. A context 

menu will open: 

 

Click "Delete the macro" in order to remove the macro from the bar. Caution: If you have 

not exported the macro in advance, it will be lost! You may read how to export and import 

macros again on page 66. 

Click the "Edit the macro" button in order to open the macro in the editor. The editor for 

Windows macros and the editor for AutoCAD (LT) or BricsCAD macros are very similar. They 

only differ in the kind of the macro that is generated. You will learn more about the 

components and functions of the editor starting on page 61. 

Let’s take a look on how to adapt the macro for sending coordinates to a text file, so that you 

will be able to send the coordinates of a point that you have measured in a scan to a CAD 

system, e.g. to IntelliCAD. Open the macro  as described above: 
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In the upper part of the editor you find the macro definition. The type of measurement has 

been set to point measurement. Keep this setting since you want to send point coordinates. 

The macro itself is, at the moment, described with: 

|x| |y| |z|<enter> 

That means, VirtuSurv sends the X, Y and Z coordinates, each separated by space and 

followed by ENTER, into the selected Windows application. 
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Most CAD systems (IntelliCAD as well) expect the X, Y, Z coordinates separated by a 

comma for their drawing commands. Go to the macro definition and replace the spaces 

between the coordinates by commas. Leave the <enter>. Most CAD systems finish the entry 

of the coordinates with ENTER. 

|x|,|y|,|z|<enter> 

The unit and the decimal separator are not configured in the macro definition but with the 

global command "Configure Measurement Unit"  from the "Measure mode" menu (see 

chapter 3.3.1 ). Usually, CAD software expects a point as decimal separator in the 

coordinate. Therefore ensure, that the measurement unit has been configured accordingly 

before sending the coordinates. 

You may customise the appearance of the buttons for the macro in the lower part of the 

macro editor. Keep width and height as they are. Activate the "Text for Button" option and 

enter "XYZ" as Text for the button. As text for the tool-tip enter for example "Send XYZ 

coordinates to CAD". The name of the macro is to be "XYZ CAD". At the very bottom you will 

see a preview for the button. 

Confirm you adaptation with [OK]. You now have a macro with which you can send 

coordinates to IntelliCAD and to other CAD systems. Of course it is possible, to simply 

generate coordinate lists in a text file with the same macro. 

  

3.4.2 Create new Windows macros 

Open the macro bar  and click the [New Macro] button in order to create a new macro 

for the sending of measurement values into any application. The macro editor will open. You 

define the macro in the upper part, in the lower part you configure the appearance of the 

button. Please do not forget to assign a meaningful name to the macro. The macro name will 

be displayed when exporting or importing macros. 
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For macros for sending to any Windows application, VirtuSurv distinguishes between two 

kinds of measurement: point measurement and distance measurement. A macro for point 

measurement is composed of coordinates and control characters. For the distance 
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measurement you can decide whether the slope distance, the horizontal distance, the vertical 

distance or a combination of distances is to be sent. 

Grammar used in VirtuSurv Windows-macros 

General control items: 

Tabulator <tab>   

Enter <enter>   

Cursor control     

Left, right <left>, <right>   

Up, down <up>, <down>   

      

Components for point measurement: 

X coordinate |x|   

Y coordinate |y|   

Z coordinate |z|   

      

Components for distance measurement: 

Slope distance |slope|   

Horizontal distance |horizontal| (e.g. for the width of things, doors, windows) 

Vertical distance |vertical| (e.g. for the height of things, doors, windows) 

  

Text that is not included in <> or | | will be passed directly to the application. If you would like 

to separate the coordinates by a semicolon, just enter the semicolon. If you want to write a 

prefix or suffix in front of or behind a measurement, simply enter it as text. Spaces, which 

have been entered between components, will also be passed directly. 

  

Examples: 

Sending the X, Y and Z coordinate into three different Excel columns with line break: 

|x|<right>|y|<right>|z|<down><left><left> 

  

Sending the horizontal distance and the vertical distance between two points, separated by 

semicolon, followed by ENTER (with "Width" or "Height" as prefix and "m" for metre as 

suffix): 

Width: |horizontal| m; height: |vertical| m<enter> 
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Hint: 

The unit and the decimal separator are not configured in the macro definition but with the 

global command "Configure Measurement Unit"  from the "Measure mode" menu (see 

chapter 3.3.1). 

  

Example macros for Rhinoceros: 

Macro for creating a planar surface: 

  

_Plane<enter>_3Point<enter>w|x|,|y|,|z|<enter> 

  

VirtuSurv sends this macro definition into Rhino’s the command line as soon as you click a 

point in the scan: 

_Plane starts the command “PlanarSurface“ 

<enter> control string for “Enter“ confirms the command input 

_3Point calls the command option “3Points“ 

<enter> control string for “Enter“ confirms the command option 

w the „w“ in front tells Rhino the coordinates refer to the world coordinate system. 

|x| X coordinate of the clicked point 

, Comma as coordinate separator 

|y| Y coordinate of the clicked point 

, Comma as coordinate separator 

|z| Z coordinate of the clicked point 

<enter> control string for “Enter“ confirms the coordinate input 

With the mouse click into the scan the macro is finished. If further coordinates are needed for 

the command, another macro needs to be started. For the “Create PlanarSurface” command 

this can be accomplished by sending further coordinates using following additional macro: 

w|x|,|y|,|z|<enter> 

This macro does not send any command to Rhino but simply the coordinate of the clicked 

point with a “w” for the world coordinate system in front of it. The macro is finished by sending 

an “Enter”. This macro can be used universally and in combination with different Rhino 

commands. Even if you have not created a VirtuSurv macro for the Rhino command. 

With this knowledge of the structure of the Rhino macro definitions you can now create your 

own individual macros for customising VirtuSurv to your needs when working with Rhino. 
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Hint: We have prepared further useful Rhino macros. You find these macros on our webpage 

which you can access by clicking the  button in the “Help” menu or on the VirtuSurv tool-

bar. In Chapter 3.4.4 you learn how to import these macros. Also read on page 27ff, how 

you can work with VirtuSurv and Rhino. 

3.4.3 Create new AutoCAD macros or BricsCAD macros 

Open the relevant macro bar  or  and click on the [New Macro] button in order to 

create a new macro for sending AutoCAD or BricsCAD commands. The macro editor will 

open. You define the macro in the upper part, in the lower part you configure the appearance 

of the button. Please do not forget to assign a meaningful name to the macro. The macro 

name will be displayed when exporting or importing macros. 
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Grammar used in VirtuSurv AutoCAD/BricsCAD macros 

Components for sending coordinates: 

3D coordinates for exactly one point 
|@3d| 

2D coordinates for exactly one point |@2d| 

3D coordinates for an infinite number of points |~3d| 

2D coordinates for an infinite number of points |~2d| 

  

A macro consists of: 

 CAD control items (e.g. ^C in front for cancelling or ^M or space for ENTER) 

 CAD commands (displayed in blue below) 

 Where applicable command line options of the CAD commands (displayed in green 

below) 

 As well as the coordinate components specified above. 

With the help of examples it will be easiest for you to learn which manifold options you have 

and how the control items are to be used. The use of upper and lower case letters is not 

important. Knowledge about the functioning of CAD command line call up is an advantage for 

the generation of macros. We would be happy to train you. 

Important: There is a command line version (command name with minus prefix) for every 

AutoCAD command (the dialogue based as well). Everything you can enter into the AutoCAD 

command line can be transferred with a VirtuSurv macro. 

  

Examples: 

Drawing lines in 3D in AutoCAD: 

^C^C_LINE |~3D|_CL ^M 

The AutoCAD control characters ^C^C finish commands, which could still be active in 

AutoCAD. _LINE is the language independent AutoCAD command for drawing lines. In this 

way the macro will work in a Russian or German AutoCAD as well. Between the AutoCAD 

command and the component for sending coordinates is a space, since in AutoCAD the 

space is used to confirm the inputs or commands. That means the space is the same as 

ENTER. You may also write ^M (as ENTER) instead of the space into the macro. AutoCAD 

expects any number of 3D points for drawing lines, therefore the |~3d| component is used. 

_CL is the AutoCAD command line option for closing the line run. 

To finish the macro you can click the button in the macro bar. You will have to finish the line 

command in AutoCAD yourself, since it is an open macro with an infinite number of points. 
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You can decide yourself whether to finish with ENTER or ESC or if you want to use the 

"Close" option. You may also finish the macro by clicking the right mouse button in the 

scan window. At the same time the command in AutoCAD is finished too using the 

“close” option. 

You want to draw only one line (two 3D points)? Change the macro as follows: 

^C^C_LINE |@3d||@3d|^C^C 

Please note that there must not be any space between the placeholders for the 3D 

coordinates. Since the number of points is limited to two, the line command can be finished at 

the end of the macro - therefore ^C^C at the end. Macro and line command are here 

automatically finished. 

  

Drawing a circle through three points in AutoCAD: 

^C^C_CIRCLE^M3p |@3d||@2d||@2d| 

Please note that there has to be a space or ^M behind the AutoCAD command. The 3P 

option has to be called up in order for the circle to be drawn through three points on the 

circumference. A circle is a plane element in AutoCAD, which will always be drawn parallel to 

the XY plane of the current user coordinate system (UCS) at the height of the Z value of the 

first point. Therefore AutoCAD expects 3D coordinate for the first point but only 2D 

coordinates for the following two points. Keep this in mind for all 2D AutoCAD drawing 

elements. The circle command is automatically finished after entering the three points and 

the macro is also finished without any further interaction. 

  

Defining UCS through three points in AutoCAD: 

^C^C_UCS _3 |@3d||@3d||@3d| 

This macro runs the AutoCAD command for the definition of a UCS. Please note that there 

has to be a space (or ^M for ENTER) after the command name. _3 is the command line 

option, which states, that the UCS will be defined by three points. Firstly, AutoCAD expects 

the point for the origin of the new UCS, then the direction of the positive X axis and at last a 

point with positive Y coordinate. As user of this macro you have to know this in order to click 

the three points in the scan in the correct order. 

  

You may also run several commands successively in one macro. 

Here an example: 

^C^C_Line |~3d|^C^C_Circle 3p |@3d||@2d||@2d|^C^C 

A run of lines is drawn through a previously not defined number of points and afterwards a 

circle through three points. How does VirtuSurv know when the line is finished and when to 
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begin drawing the circle? When you have clicked enough points for the line run in the scan, 

simply click the right mouse button in the scan window. With this the sub macro for the 

drawing of the line is finished and VirtuSurv executes the next command in the macro – here 

the drawing of the circle. 

  

Drawing a line on a certain layer (AutoCAD): 

^C^C_-LAYER^M_T^MWand^M_M^MWand^M_S^MWand^M^M_LINE^M|~3d|^M 

The language independent command line version of the layer manager will be started 

(_-LAYER). After that the _T option unfreezes the layer with the name Wall if it should be 

frozen. Then the _M (make) option is used in order to create the layer Wall if it does not yet 

exist in the AutoCAD drawing. The layer Wall is set 'current' with the _S option. The layer 

command is finished by a double ENTER and the line command will be called up. ^M was 

written as closure, so the line command and the macro can be finished by a right-click in the 

scan. If you finish the macro per click on the relevant button, the line command in AutoCAD 

will still be active and you can decide yourself whether you want to close the line run or not. 

Do you always want to generate closed line runs with the macro? Then insert the _C option 

for "Close" before the last ^M. 

  

Inserting a block that is already defined in the drawing (AutoCAD): 

^C^C_-INSERT^Mlampe^M|@3D|^M^M^M 

The language independent command line version of the INSERT command will be started (_-

INSERT). "Lamp" is the name of the block definition in the AutoCAD drawing template. With 

|@3d| the 3D coordinates of a single point are transferred to AutoCAD. The macro ends with 

three times ^M for ENTER: the first one confirms the coordinate. The other two ENTER 

confirm the insertion scale and the rotation of the block like they have been entered during 

previous block insertion (default: 1 for the scale, 0 for the rotation). 

Hint: Not only AutoCAD commands but also commands of AutoCAD plug-ins are usable in 

the VirtuSurv macros. FARO provides a number of AutoCAD plug-ins.  

Hint: We have prepared additional useful macros (e.g. for drawing 2D). You find these 

macros on our webpage which you can access by clicking the  button in the “Help” menu 

or on the VirtuSurv tool-bar. In Chapter 3.4.4 you learn how to import these macros. 

3.4.4 Transfer macro definitions to other computers 

In order for you to be able to transfer VirtuSurv macros to other computers and to make it 

available to other users, there are the [Export Macros] and [Import Macros] buttons at the 

bottom of all macro bars ( , and ). 
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Click [Export Macros] to save your macros to an external text file. Select the folder where 

you want to file the macros and confirm with [OK]. In the target folder a sub directory with the 

name "VirtuSurvMacros" will be created. It contains a folder "MacroImages" where the icons 

of your self-defined macros will be stored if applicable. The macros themselves are written to 

AUTOCAD MACROS.TXT or WINDOWS MACROS.TXT. 

Just forward the "VirtuSurvMacros" folder to other VirtuSurv users or copy the folder to the 

new computer. 

On the target computer open the desired macro bar in VirtuSurv. Then click on [Import 

Macros]. Browse to the copied "VirtuSurvMacros" folder in the file selection window and 

open AUTOCAD MACROS.TXT, BRICSCAD MACROS.TXT or WINDOWS MACROS.TXT 

according to the kind of macro you would like to import. The following dialogue box opens: 

 

On the left you find the list of the macros for the import, contained in the TXT file, on the right 

the list with the macros already existing in VirtuSurv. Select the macros you would like to 

import and then click [Import >]. With [Import all] you can import all macros at once. 

If a macro to be imported has the same name as an existing macro a dialogue box will open, 
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where you can change the name of the macro to be imported. For safety reasons existing 

macros are not automatically overwritten. 

In order that you do not have the same macro twice in the macro bar, but just with different 

names, it is possible to compare the contents of an existing macro with the contents of a 

macro to be imported. To do so select the macros you want to compare in the left and right 

list. The content of the according macro is displayed in the window below. 

When you have made your choice for the import, confirm with [OK]. 

3.5 Create a new project 

VirtuSurv can only be used with one project opened. Therefore you may create a new project 

directly from the Welcome screen. Just click the relevant button . Now enter a project 

name and select the path for where to save the project. 

If you have just been working on a project in VirtuSurv and want to create a new one you 

may run the "New Project"  command from the "File" menu or the tool-bar. After entering 

directory and name the previous project will be closed. If relevant you are asked if you want 

to save changes. 

In the target folder VirtuSurv creates a project directory with the name of the project. It 

contains the VirtuSurv project file {PROJECTNAME}.PVP, which is opened in VirtuSurv and 

will reference the single scans you add to the project.  

The name of the newly generated, empty project appears in the Project Explorer. 

Now you can add scans to the project either by importing new scan data (see chapter 3.6 ) or 

by adding VirtuSurv single scans (PVS files). For the second option just right click on the 

project name in the Project Explorer and run the “Add scans” command from the context 

menu. A dialogue box opens. Click the [Add scans from directory] button and browse to the 

directory containing the scans. VirtuSurv will list all single scans it found there. You may now 

select all or just some of the scans and add them to your new project by clicking [OK]. 

VirtuSurv will copy them to the new project directory. Please save the project ( ). The 

changes are now written to the project file. 

If scans of different scanner types have been registered in the same superior coordinate 

system, you can combine them in one project. 

3.6 Import scan data 

In VirtuSurv the scan data is displayed in a photo-like planar view. The three dimensional 

information of the scan is maintained. VirtuSurv works with an optimised format to avoid long 

waiting times when opening the scan data and when working with them. 
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VirtuSurv supports the import of different scan data formats. At the moment these are: 

 PTX (format which is supported by different scanner manufacturers) 

 PTG (Leica, but also supported by other manufacturers) 

 FLS, FWS, LSPROJ (FARO single scans and projects) 

 CL3, CLR (Topcon) 

 E57 (independent standard exchange format, supported by Riegl, Trimble, FARO, 

Autodesk and many more manufacturers) 

  

If the scans have been registered in the same superior coordinate system, the single scans 

of different scanner types can be combined in one project. You learn how to create a new 

project in chapter3.5. 

If you want to import a scan or a scan project, run the "Import Scans"  command from the 

"File" menu. The import dialogue box opens: 

 

Section "Select scans or project" 

Select the data you want to import under "Select scans or project". Click on [Browse] and 

browse to your single scan files or your scan project. You may select several single scans at 

the same time. If the single scans are filed in different directories, press [Browse] again until 

you have selected all of the scans that you want to import. If, instead of single scans, you 

have selected a scan project file (e.g. FWS, LSPROJ or ZFPRJ), it can take a few seconds 
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before the single scans will be displayed in the import list. All of the selected scan files will be 

shown together in the import list. Should you want to exclude individual files from being 

imported, remove the selection tick before the particular scan. Hint: You can highlight (light 

blue) all scans with Ctrl+A, or Ctrl+left mouse button or Shift+left mouse button for multiple 

scans. The selection tick will then be respectively removed or set for all highlighted scans. 

Button [Scan view orientation] 

Use this option when you are unsure whether your scans have been saved standing on their 

heads or as a mirrored image, as the case may be. You can then ensure before the time-

consuming import, whether the scans will be correctly aligned when imported. Also take note 

of the information further below on specific scan data formats. 

With a single click on the button [Scan view orientation] you can create a preview for one of 

the scans highlighted (light blue) in the list. It can take a few seconds before the dialogue box 

opens, as the preview must first be computed: 

 

You can see in the black and white preview how the scan that you selected will look like after 

it has been imported. To the right of the preview pane in the “Operations” group you will find 

some tools with which you can correct the alignment of the scan view. 

 [New centre line]: Click on this button and then in the preview precisely where you want to 

define the new vertical centreline of the scan view. This is useful should a scan be split on 

an inappropriate position. 
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 [New centre]: Click on this button and then in the preview precisely where you want to set 

the new centre point of the scan view. This is useful where the scanner has been set up 

horizontally, but you now want to work on a fresco on the ceiling. In the preview click on a 

point on the ceiling: 

 

This now becomes the centre of the new view 

 

 [Rotation]: Here you can rotate the scan view by a defined angular value. 

You can use multiple operations in succession on a single scan. 

Example of use PTX scans: 

Preview without any operations 

 

270° clockwise rotation 
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In the pane under the preview you can see which operations have been carried out, to show 

how it now is and how it will be imported, just as it can now be seen in the preview. 

With [Undo last operation] you can in each case undo the previous operation. Should you 

want to apply the operations to all of the scans that are to be imported, activate the option 

“Apply to all scans”. Caution: It is not advisable to apply the operation “New centre line” to all 

scans, as it is rather an individual operation for single scans. 

With [OK] you accept all of the settings for the import and return to the import dialogue box, 

whereas with [Cancel] the settings will be discarded. 

Scans with a preview already calculated are highlighted light-green in the scan list. 

  

Section "Import settings" 

Here you state in which unit (Scan unit) your scan data exist. This information is very 

important! It is the basis for the conversion into the measurement unit. VirtuSurv can only 

calculate the measurement values correctly, when you state the correct Scan unit during the 

import. 

With the 'resampling' you determine, whether you want to import all scan points to VirtuSurv 

or if the scans are to be thinned out. Thinning out reduces the data volume. It is only 

recommendable, if you scanned with a much higher resolution as is needed for the required 

evaluation. 

After you have entered all settings, start the import by clicking [OK]. According to the project 

size (resolution, number of scans) and processor power this may take a fairly long time (up to 

several hours). 

When the import is finished and all scans have been imported successfully, you will get an 

appropriate message, which you close by clicking [OK]. Now the scans will be displayed in 

the Project Explorer. The scanner positions will also be displayed in the scan map. 

VirtuSurv will automatically generate one folder per single scan in the project directory. 

The name is {Name of the original scan file}-SingleScan. 

The SingleScan directory contains the PVS file, which can be opened with VirtuSurv, as well 

as a folder with images that are referenced in the PVS file. The PVS file itself is referenced in 
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the VirtuSurv project file (*.PVP). Also every VirtuSurv single scan knows which project it 

belongs to. 

3.6.1 Remarks on the PTG format 

PTG files do sometimes contain data upside down. 

Should you be unsure whether your scans will be standing on their heads and thereby must 

be rotated on import, use the preview in the import dialogue box (button [Scan view 

orientation]). 

3.6.2 Remarks on PTX import 

PTX is an ASCII-Format, which is supported by different scanner manufacturers. 

Unfortunately this format is not standardised and scanner manufacturers save the format of 

their PTX files differently. They will be correctly displayed in the manufacturers’ software. 

Whilst the manufacturers software will display its own PTX format correctly it is difficult for us 

and VirtuSurv to automatically accommodate all of the differences. We therefore highly 

recommend that with this format to use the preview in the import dialogue box (button [Scan 

view orientation]). 

3.6.3 Remarks on Topcon import 

Please note that CL3 files can only be imported, if the relevant *.ij and *.alg files are available 

it the same folder. 

CLR files can only be imported, if the relevant *.alg files are available it the same folder. 

3.7 Exporting point clouds 

An advantage of VirtuSurv, is that you do not have to import the large and ponderous laser 

scan data into the CAD system in order to be able to draw with them. However, if you want to 

generate point clouds from the data, in order to forward them to customers and other users 

for example, you may do that with VirtuSurv. 

You can export projects, scans and parts of scans into point clouds. At the moment VirtuSurv 

supports the export to LAS format, PTS (ASCII) format and FARO/kubit’s point cloud format 

PTC. LAS files can for example be imported into AutoCAD (starting with version 2011). With 

FAROs AutoCAD plug-in "PointSense" for the evaluation of laser scanner data, PTS and 

PTC files can be imported, even into older AutoCAD versions. 
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3.7.1 Exporting complete projects 

For the export of a complete project right-click on the project name in the Project Explorer 

and select the  "Export all…" option from the context menu. The export dialogue box 

opens: 

 

Section "Define output file” 

Here you determine, into which point cloud format will be exported and if the complete project 

is to be written into one single point cloud or if one point cloud is to be generated for every 

scan. If you want to export only one point cloud, you are prompted for the target folder and 

the name for the point cloud file after clicking [Define]. When exporting into several point 

clouds you only have to state the name of the target folder and the name of the single point 

clouds are generated form the name of the according scan. 

Please note, that it is only possible to export into several point cloud files, when exporting into 

the PTC format, since very large (more than 50 million points) PTC point clouds cannot be 

handled in AutoCAD. 

Section "Properties" 

Determine the desired measurement unit for the point cloud to be generated. 

You may thin out the data during the export by rows and columns. The default setting is 

"Every Row" and "Every Column" that means everything will be exported and nothing will be 

thinned out. 
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When clicking on [Count all points], VirtuSurv will determine how many points will be 

exported. This way you can control, how large the point cloud is going to be and you can 

estimate if it can still be handled in AutoCAD for example. 

Click [Export] in order to start the export. 

3.7.2 Export of scans and parts of scans 

In order to export selected scans or certain parts of scans - in the Project Explorer – right-

click on the desired scan and select the "Export..." entry from the context menu. Please 

note that the scan view has to be opened to do so. The export dialogue box for single scans 

opens: 

 

Under "Define output file" you determine the target folder for the exported point cloud, enter 

the file name and define the file type (LAS, PTS or PTC). To do so click [Define]. 

In the "Properties" section you determine the desired measurement unit for the point cloud 

to be generated (Unit for export). You may thin out the data during the export by rows and 

columns. The default setting is "Every Row" and "Every Column" that means everything will 

be exported and nothing will be thinned out. 
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Section "Select area to export" 

Here you can define the area which is to be exported. When clicking on [Count all points] 

VirtuSurv will determine how many points lie in the selected area. This way you can estimate 

if the exported point cloud will be manageable. 

With the [Via box] button you start the area selection with a rectangular selection window. 

The dialogue disappears and you can select the area to be exported. 

 

With the [Via polygon] button you start the area selection via a freely definable polygon. The 

dialogue box disappears and you select the area to be exported by clicking the surrounding 

polygon. Caution, the first line will only be visible, when you have clicked the second point. 

You close the polygon by clicking the right mouse button. 
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If you want to export the complete scan, you do not have to select an area, simply click 

[Export]. 
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4 3rd Party Libraries 

4.1 VXL Library 

VirtuSurv uses the VXL library 

Content of the VXL – Copyright licence: 

  

Copyright (c) 2000-2003 TargetJr Consortium 

GE Corporate Research and Development (GE CRD) 

1 Research Circle 

Niskayuna, NY 12309 

All Rights Reserved 

Reproduction rights limited as described below. 

  

Permission to use, copy, modify, distribute, and sell this software 

and its documentation for any purpose is hereby granted without fee, 

provided that (i) the above copyright notice and this permission 

notice appear in all copies of the software and related documentation, 

(ii) the name TargetJr Consortium (represented by GE CRD), may not be 

used in any advertising or publicity relating to the software without 

the specific, prior written permission of GE CRD, and (iii) any 

modifications are clearly marked and summarised in a change history 

log. 

  

THE SOFTWARE IS PROVIDED "AS IS" AND WITHOUT WARRANTY OF ANY KIND, 

EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY 

WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

IN NO EVENT SHALL THE TARGETJR CONSORTIUM BE LIABLE FOR ANY SPECIAL, 

INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND OR ANY 

DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 

WHETHER OR NOT ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR ON 

http://vxl.sourceforge.net/


 VirtuSurv 

 | 79 

ANY THEORY OF LIABILITY ARISING OUT OF OR IN CONNECTION WITH THE 

USE OR PERFORMANCE OF THIS SOFTWARE. 

  

4.2 Qt Framework 

VirtuSurv uses Qt 

  

  

  

  

  

http://qt.nokia.com/
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5 Licence Agreement 

This is a Licence Agreement, not a Purchase Contract, between you (herein after known as 

the "Licensee") and FARO Technologies, Inc. (herein after known as the "Licensor" or 

"FARO"). By the opening of the sealed program package you are agreeing to the conditions 

of this Agreement. The rights to use, transfer and copy are limited by this Agreement. 

1. Subject of this Agreement 

The subject of this Agreement is the licensing of a FARO software package. It is delivered to 

the Licensee in the form of a software program. The Licensee is not entitled to claim the 

source code. The software package also includes a disc, manual and software copy 

protection. 

The parties to this Agreement hereby agree that the program is eligible for protection and of 

being protected under copyright law. The Licensor or any third party have intellectual 

property rights on the goods supplied. So far as any third party is entitled to the rights, the 

Licensor has the appropriate rights of use. 

2. Scope of Use 

The Licensee is hereby granted for the duration of this Agreement the simple non-exclusive 

and personal right (licence) to use the computer programs on the disc subject to the following 

conditions. 

The licence for the software may not be used by the Licensee at any one point in time on 

more than a single computer. 

The Licensee has the right to make a backup copy of the programs. The program package 

and the company names, trade marks and copyright notices contained therein, must not be 

changed or altered in any way or manner. The Licensee is not entitled, in any way or form, to 

copy or otherwise duplicate the software and the written material, in whole or in part in its 

original or in any form merged with or embedded in any other software. 

The Licensee hereby agrees not to disassemble or have disassembled the programs or any 

part thereof. Should the Licensee require information on how to achieve interoperability, then 

it will be supplied by the Licensor. Likewise it is not allowed to translate the written material or 

to amend or to produce derivative works there from. 

The Licensee is not entitled to remove the software copy protection that is bound to the 

software or to bypass it in any other way. 

The Licensee has to ensure that no programs, documentation or duplicates thereof can be 

accessed by any third party without the express permission of the Licensor. In particular the 

Licensee is not allowed, without the express permission of the Licensor, to transfer, to rent or 

to loan the software to any third party. Basically, a transfer is only possible if the third party 

has declared to comply with the terms and conditions of this Agreement. This must be 
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expressly pointed out to the third party. With an approved transfer all the rights of use of the 

transferor are forfeited. 

Any further use is prohibited. 

3. Warranty 

The software has been developed with due care and diligence and with regard to accepted 

programming methods. With the currently best available technology it is not possible to 

completely rule out errors in the development of the software. 

The Licensor accepts no liability for any errors and does not guarantee the specific suitability 

of the software to meet the Licensee's requirements. The responsibility for the correct choice 

of and the consequences arising from the use of the software as well as the intended or 

achieved results lies solely with the Licensee. Warranty claims are excluded, to the extent 

allowed by law. 

The Licensor is in particular not liable for any indirect damages or any consequential 

damages caused by errors or defects in the licensed software. There shall be no limitation of 

liability for wilful intent, gross negligence and guaranteed quality. 

4. Loss of the Dongle 

FARO products are protected by a dongle. The dongle contains complete licensing 

information. Therefore your licence is irremovable embedded in your dongle. If the dongle is 

lost the Licensee is obligated to promptly report the loss of the dongle to FARO (Licensor). 

The dongle (the licence) will not be replaced by FARO. 

5. Duration of the Agreement 

This Agreement is open ended (none expiring). The Licensee's rights to use the software will 

automatically expire without notice, if he breaks any one of the conditions of this Agreement. 

Upon expiration of the right to use following a breach of this Agreement the Licensee is 

obligated to destroy all parts of the program package supplied with this licence, together with 

all copies including any modified copies. 

6. Final Provisions 

Should one or more of the provisions of this Agreement be or become invalid, or should the 

Agreement contain an omission, all of the remaining provisions shall retain their legal 

effectiveness. The parties agree that the invalid provision shall be replaced by a valid 

provision that come closes to the commercial effect intended by the parties hereto. 

Any change to this Agreement must be made in writing. There are no ancillary verbal 

agreements. 

This Agreement shall be subject to the laws of the United States of America. The executive 

place of jurisdiction for all disputes under this Agreement shall be the state of Florida, USA. 
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Supplementary Provisions for Use with AutoCAD LT 

FARO Software uses LTX under licence from ManuSoft (http://www.manusoft.com) for the 

required software support, to be able to load and run FARO Software from within AutoCAD 

LT®. You are hereby granted permission to use for an unlimited period of time, the software 

LTX as an integral part of the FARO Software. However permission has only been granted 

exclusively for the use of LTX in connection with the FARO Software or which it has been 

developed, planned and approved. Any other use of the LTX files is expressly prohibited, and 

every violation of this Licence Agreement will be prosecuted to the full extent that the law 

provides. Neither ManuSoft nor any possible heir or legal successor guarantees implicitly or 

explicitly the applicability or the freedom from defects of LTX when used by the end user or 

any third party. ManuSoft disclaims all liability for any direct, indirect, special, incidental or 

consequential damages in any connection with LTX. 
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